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1. Description

The Plexor® HY System(a–f) is a novel real-time PCR system for quantitation of total human
(autosomal) and human male (Y) DNA within a sample. This Technical Manual describes the
Plexor® HY System and provides instructions for use with the Bio-Rad iQ™5 Real-Time PCR
Detection System, including reaction setup, real-time PCR instrument programming and data
analysis using the Plexor® Analysis Software.

The Plexor® technology takes advantage of the specific interaction between two modified
nucleotides to achieve quantitative PCR analysis (1–3). One of the PCR primers contains a
modified nucleotide (iso-dC) linked to a fluorescent label at the 5´ end. The second PCR primer
is unlabeled. The reaction mix includes deoxynucleotides and iso-dGTP modified with the
quencher dabcyl. Dabcyl-iso-dGTP is incorporated opposite the iso-dC residue in the primer.
The incorporation of the dabcyl-iso-dGTP at this position results in quenching of the
fluorescent dye on the complementary strand and a reduction in fluorescence, which allows
quantitation during amplification (Figure 1).

With the Plexor® technology, accumulation of product is accompanied by a decrease in
fluorescence as shown in Figure 2.

The Plexor® technology allows the use of a melt curve or dissociation curve to determine the
melting temperature (Tm) of the products following amplification (Figure 3). This is useful in
assessing the specificity of the reaction.
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Figure 1. Schematic diagram illustrating the Plexor® real-time PCR process.
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The fluorescein dye of the Plexor® HY System is used to detect a human autosomal DNA target.
The primers amplify a multicopy, 99bp target on chromosome 17. Data from this reaction are
used to quantify the total amount of human DNA in a sample.

The CAL Fluor® Orange 560 dye of the Plexor® HY System is used to detect a Y-chromosomal
DNA target. The primers amplify a multicopy, 133bp target on the  Y chromosome. Data from
this reaction are used to quantify the total amount of human male DNA in a sample.

Figure 2. Representative Plexor® amplification curves. The amplification curves show the
fluorescence (in relative fluorescence units, RFU) at each cycle of the reaction. The amplification
threshold is indicated by a horizontal line across the graph. This line is used to determine the cycle
threshold (Ct) for the samples.
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Figure 3. Representative Plexor® melt curves. Melting temperature is empirically determined 
by plotting the change in fluorescence with temperature (–dRFU)/dT versus temperature and
determining the temperature at which the greatest rate of change in fluorescence occurs.

49
33
T
B

Expected target melt temperature range

Melt
threshold

tm296.0212:tm293.0707 2/16/2012 4:00 PM Page 3



1. Description (continued)

The CAL Fluor® Red 610 dye of the Plexor® HY System is used to detect the Internal PCR
Control (IPC), which is added to every reaction. The primers amplify a novel DNA sequence
added as a template to the reaction mix. The amplified product is 150 base pairs. Data from this
target are used to monitor inhibition of amplification in samples.

The IC5 dye of the Plexor® HY System is used as a passive reference. IC5-labeled reagent is
added to the reaction mix for every sample. Data from the three amplification channels
(fluorescein, CAL Fluor® Orange 560 and CAL Fluor® Red 610) can be normalized to this signal.

The Plexor® HY System uses a hot-start chemistry. Reaction setup can be performed at room
temperature and is amenable to automation.

2. Product Components and Storage Conditions

Product Size Cat.#
Plexor® HY System 200 reactions DC1001
Not for Medical Diagnostic Use. Includes:

• 2 × 1ml Plexor® HY 2X Master Mix
• 200µl Plexor® HY 20X Primer/IPC Mix
• 150µl Plexor® HY Male Genomic DNA Standard, 50ng/µl
• 2 × 1.25ml Water, Amplification Grade
• 1 Protocol

Product Size Cat.#
Plexor® HY System 800 reactions DC1000
Not for Medical Diagnostic Use. Includes:

• 8 × 1ml Plexor® HY 2X Master Mix
• 4× 200µl Plexor® HY 20X Primer/IPC Mix
• 3 × 150µl Plexor® HY Male Genomic DNA Standard, 50ng/µl
• 5 × 1.25ml Water, Amplification Grade
• 1 Protocol

Storage Conditions: Store the Plexor® HY System at –20°C. Once thawed, store the Plexor® HY
Male Genomic DNA Standard at 4°C; do not refreeze. For short-term storage, less than 1 week,
the other components of the system can be stored at 4°C. Minimize the number of freeze-thaw
cycles.

Item Available Separately

Product Cat.#
Plexor® Calibration Kit, Set A DC1500

• 50µl Plexor® Concentrated Fluorescein Calibrator
• 50µl Plexor® Concentrated CAL Fluor® Orange 560 Calibrator
• 50µl Plexor® Concentrated CAL Fluor® Red 610 Calibrator
• 50µl Plexor® Concentrated IC5 Calibrator
• 11ml Plexor® 1X Calibration Buffer
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3. General Considerations

The key to the Plexor® technology is the quenching of a fluorescent reporter due to the site-
specific incorporation of dabcyl-iso-dGTP. As a result, the fluorescent signal from a Plexor® HY
reaction decreases as PCR product accumulates. Real-time instrument software can record the
quenching data, but most cannot determine amplification thresholds, threshold cycle (Ct) or
melting temperatures. Data analysis is accomplished by exporting the data to the Plexor®

Analysis Software. The Plexor® Analysis Software is compatible with data from all supported
instruments. The software is compatible with Windows® 98 and later operating systems.

Before using the Plexor® HY System, be sure you have the forensic release of the Plexor®

Analysis Software. All instructions in this Technical Manual refer to the forensic release of the
software. The Plexor® Analysis Software and instructions for software installation can be
downloaded free of charge from the Promega Web site at: www.promega.com/plexorhy/

We recommend using designated work areas and pipettes for pre- and postamplification steps
to minimize the potential for cross-contamination between samples and prevent carryover of
nucleic acid from one run to the next. Wear gloves, and change them often. Prevent
contamination by using aerosol-resistant pipette tips. Always include a no-template control
(NTC) reaction to detect contamination. We recommend performing NTC reactions in duplicate.

Do not unseal reaction plates after amplification is complete. Unsealing the plates increases
the risk of contaminating subsequent reactions with amplified product.

4. Calibration Protocol

Before using the Plexor® HY System, the instrument must be calibrated for fluorescein, 
CAL Fluor® Orange 560, CAL Fluor® Red 610 and IC5. The Plexor® Calibration Kit, Set A,
includes aliquots of these four calibrators at a 100X concentration, along with a calibration
buffer for use as a diluent to create a pure dye calibration plate.

Before performing the pure dye calibration, perform the mask and background calibrations 
as recommended by the instrument manufacturer. Follow the guidelines in the iQ™5 optical
system software help file or instrument manual (see Notes 1 and 2).

Materials to Be Supplied By the User
• Plexor® Calibration Kit, Set A (Cat.# DC1500)
• real-time PCR instrument and related consumables, 

such as the appropriate PCR plate and plate film or caps

1. Thaw the four Concentrated Calibrators (fluorescein, CAL Fluor® Orange 560, 
CAL Fluor® Red 610 and IC5) and Calibration Buffer.

2. Vortex the Concentrated Calibrators and Calibration Buffer to mix.

3. For each spectral calibrator, dilute 5µl of Concentrated Calibrator in 495µl of
Calibration Buffer.

4. Vortex the diluted spectral calibrators for 3–5 seconds to mix.

5. For each diluted spectral calibrator, dispense 20µl to each well in a separate column
of a 96-well optical plate (8 wells per dye).

6. Apply the appropriate plate seal. Record the bar code number or mark the side of 
the plate skirt to designate the Plexor® HY spectral calibration plate.

!
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4. Calibration Protocol (continued)

7. Centrifuge plate briefly. Protect plate from light.

8. Follow the protocol in the instrument guide to perform pure dye calibration with the
Plexor® HY calibration plate. The protocol is summarized below with information
specific for Plexor® HY dye calibration:
a. Open the iQ™5 optical system software. Select the Calibration Module, then the 

Pure Dye tab. Select “Create New” in the Plate Setup window (Figure 4, lower
right panel).

b. Choose “Select/Add Fluorophores” to launch the Fluor Selector (Figure 5).
Select/add the Plexor® HY fluors, specifying the following names and filter sets:
• Fluorescein: “FAM”, Filter Position 2
• CAL Fluor® Orange: “CO560”, Filter Position 3
• CAL Fluor® Red “CR610”, Filter Position 5
• IC5: “IC5”, Filter Position 6
Select “OK”.

c. In the Plate Setup Editor, specify the wells containing each dye (Figure 6).
• In the Plate Setup Editor, click the FAM button in the Fluorophore list to 

select the first fluorophore (FAM™).
• Select “PureDye” above the plate map. Use the cursor to define sample 

wells with the selected fluorophore (click on the column header to fill in 
an entire column, or drag across wells).

• Select the next fluorophore (e.g., CO560) from the Fluorophore list. Define 
wells as above. Repeat with the remaining two fluorophores (e.g., CR610 
and IC5).

d. Specify “Sample Volume” (20), “Seal Type” and “Vessel Type”. Give the file 
an appropriate name (e.g., “PlexorHYPureDye”), then select “Save & Exit Plate
Editing”.

e. Select “Run Pure Dye Calibration”.

Figure 4. The iQ™5 Calibration Module, Pure Dye tab.
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Notes:
1. It is not necessary to perform the external well factor calibration (see Note at the end

of Section 6.C).
2. For mask alignment, the 1X fluorescein calibrator from the Plexor® Calibration Kit

may be substituted for the Bio-Rad 10X external well factor solution to prepare the
mask alignment plate. Filter position 2 would still be used.

3. After calibration, store the calibration plate, protected from light, at –20°C. Reuse the
plate if reanalysis is necessary.

Figure 5. The iQ™5 Fluor Selector.

Figure 6. The Plate Setup Editor.
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5. Reaction Plate Setup

When using the Plexor® HY System for the first time, we recommend programming the
instrument (Section 6) before assembling the reactions. Once you are familiar with the
programming process, the instrument can be programmed after reaction setup.

Materials to Be Supplied By the User
(Solution compositions are provided in Section 10.J.)
• sterile, aerosol-resistant pipette tips
• pipettes dedicated to preamplification work
• real-time PCR instrument and related consumables, 

such as the appropriate PCR plate and plate covers or caps
• TE–4 buffer
• Plexor® Analysis Software (forensic release)

5.A. Template Preparation

Change gloves often, especially after handling high-concentration DNA. These
instructions use 2µl of template DNA per reaction. The sample volume can be
increased as long as the final reaction volume stays constant. Sample volumes
and final reaction volumes must be the same for both the DNA standards and
the unknown samples, allowing the DNA standards to be considered as a
concentration (in ng/µl) instead of input amount in ng (ng/µl × volume). The
standard curve described below uses DNA standards in the range of 3.2pg/µl
to 50ng/µl. These values can be modified if desired. See Section 10.B.

Sample DNA Templates (Unknowns)

Use 2µl of sample DNA per reaction. Performing duplicate analysis of each
sample DNA and averaging the quantitation results can reduce variability. 
The sample DNA can be diluted in TE–4 buffer, if desired.

DNA Standards

The Plexor® HY System is supplied with the Plexor® HY Male Genomic DNA
Standard, 50ng/µl. This DNA is a mixture of human male DNA. Use of other
DNA (i.e., DNA isolated from a cell line) as a standard is not recommended.

Serial dilutions of the DNA standard are amplified in the same plate as the
unknown samples, and the results are used to generate a standard curve in the
autosomal (fluorescein) and Y (CAL Fluor® Orange 560) channels to determine
the concentrations of unknown samples. We recommend performing duplicate
or triplicate amplification reactions with each dilution of the DNA standard.
Use of a dedicated set of pipettes can increase run-to-run consistency. Use the
same pipettes to dispense the DNA standards and unknown samples.

Multiple freeze-thaw cycles of the Plexor® HY Male Genomic DNA Standard,
50ng/µl, can increase variability in the standard curve. High-molecular-weight
DNA may form aggregates or concentration gradients when frozen, which may
result in sampling error. Store the DNA standard at 4°C overnight before the
first use, and vortex prior to use. We recommend long-term storage at 4°C.
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1. Thaw and vortex the Plexor® HY Male Genomic DNA Standard, 50ng/µl,
at high speed for 5 seconds. After initial thawing, store at 4°C.

2. Prepare fresh serial dilutions of the Plexor® HY Genomic DNA Standard
as indicated in Table 1. Vortex each dilution for 3–5 seconds before
removing an aliquot for the next dilution. Be sure to change pipette tips
between dilutions. Change gloves after handling high-concentration DNA.

No-Template Control
Include a no-template control (NTC) reaction for each set of reactions. Add 2µl
of TE–4 buffer to these reactions in place of the template DNA. There should be
no specific amplification product (e.g., <1.0pg/µl with a 2µl input volume)
detected in the NTC reaction. Amplification of >1.0pg/µl of DNA in the NTC
reaction indicates nonspecific amplification or the presence of contaminating
DNA.
Note: The Plexor® HY System is extremely sensitive. The NTC reaction may
show amplification products in the subpicogram range.

5.B. Reaction Setup

1. Thaw the Plexor® HY 2X Master Mix, Plexor® HY 20X Primer/IPC Mix
and Water, Amplification Grade.
Note: Do not thaw the Plexor® HY 2X Master Mix and Plexor® HY 20X
Primer/IPC Mix at temperatures above room temperature.

2. Briefly vortex the Plexor® HY 2X Master Mix and Plexor® HY 20X
Primer/IPC Mix for 3–5 seconds to mix. Do not centrifuge after vortexing,
as this may cause the primers to be concentrated at the bottom of the tube.

3. Determine the number of reactions to be set up. This should include
negative control reactions. Add 1 or 2 reactions to this number to
compensate for pipetting error. While this approach does require using a
small amount of extra reagent, it ensures that you will have enough PCR
master mix for all samples. It is critical that the same reaction mix is used
for the entire run.

4. Prepare the reaction mix by combining the Water, Amplification Grade,
Plexor® HY 2X Master Mix and Plexor® HY 20X Primer/IPC Mix as 

Table 1. Serial Dilution of the Plexor® HY Genomic DNA Standard.

Concentration Volume of DNA Volume of TE–4 Buffer
50ng/µl Use undiluted DNA 0µl
10ng/µl 10µl of undiluted DNA 40µl
2ng/µl 10µl of 10ng/µl dilution 40µl
0.4ng/µl 10µl of 2ng/µl dilution 40µl
0.08ng/µl 10µl of 0.4ng/µl dilution 40µl
0.016ng/µl 10µl of 0.08ng/µl dilution 40µl
0.0032ng/µl 10µl of 0.016ng/µl dilution 40µl
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5.B. Reaction Setup (continued)

indicated in Table 2. The reaction mix will be used to perform the NTC
reaction and amplify samples and DNA standards. To amplify a larger
input template volume, see Section 10.B.

5. Vortex briefly to mix.

6. Add 18µl of the reaction mix prepared in Step 4 to each of the appropriate
wells of an optical-grade PCR plate.

7. Add 2µl of TE–4 buffer to the NTC reactions (Figure 7).

8. Add 2µl of DNA standard or unknown sample to the reaction mix in the
appropriate wells (Figure 7). Duplicate amplification of standards is
required. Duplicate analysis of unknown samples and subsequent
averaging of the DNA concentration will reduce the impact of variability
due to pipetting, sampling or amplification.

9. Apply the appropriate plate seal.

10. Centrifuge the plate briefly to collect the contents of the wells at the
bottom. The plate is ready for thermal cycling. Protect the plate from
extended light exposure or elevated temperatures before cycling. Handle
the plate by the edges, and avoid touching the bottom of the plate.
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Table 2. Preparation of Reaction Mix for Quantitation Assays 
(assumes 2µl of template per reaction).

Component Volume (Per Reaction)
Plexor® HY 2X Master Mix 10µl
Water, Amplification Grade 7µl
Plexor® HY 20X Primer/IPC Mix 1µl
final volume 18µl

Figure 7. Schematic diagram showing distribution of the diluted DNA standard and unknown
samples (UNK) in a 96-well PCR plate.
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6. Bio-Rad iQ™5 System Setup

6.A. Thermal Cycling Program

The thermal cycling program is shown in Table 3.

1. Open the iQ™5 optical system software. Select the Workshop Module,
then Setup tab (Figure 8). Select “Create New” in the Protocol window to
open the Protocol Editor.

Figure 8. The iQ™5 Workshop module, Setup tab, displaying the browser window at upper left,
the selected Protocol window (active) at bottom left, the selected Plate Setup window at bottom
right, and the selected Run Set window at upper right.

Step

“Well Factor”
collection from
experimental

plate

Initial
denaturation:

Denaturation:
Annealing and

extension:

Melt curve:

Temperature

95°C

95°C

60°C

Time

30 seconds

5 seconds

35 seconds

Number of
Cycles

1 cycle

38 cycles

Use the default “Melt Curve” settings.

Table 3. Thermal Cycling Program.

Automatically inserted into program (90 seconds at 90°C)
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6.A. Thermal Cycling Program (continued)

2. Define the Plexor® HY profile by editing the default settings of the
protocol template in the table at the bottom of the Protocol Editor 
window (Figure 9):
a. In Cycle 1, Step 1, change “Dwell Time” to 0:30 by clicking in the

appropriate cell.
b. In Cycle 2, change “Repeats” to 38.
c. In Cycle 2, Step 1, change “Dwell Time” to 0:05.
d. In Cycle 2, Step 2, change “Dwell Time” to 0:35 and “Setpoint” to 60.0.
e. Add Cycle 3 by clicking on the “+” button in the Insert column in the

Cycle 2 row (cycle rows have a blue background). This will insert a
cycle containing 1 repeat of 1 step at the end.

f. Define Cycle 3 by choosing the Melt Curve option from the
pulldown menu in the Data Acquisition column. Use the default
Melt Curve profile (55°C to 95°C in 0.5°C steps).

3. Enter an appropriate file name (e.g., “Plexor HY”), and select “Save & Exit
Protocol Editing” to save the protocol to an appropriate directory. The
new protocol is now active in the Protocol window in the Setup tab.
Note: After programming the Protocol and Plate setup files, the user can
link them in a Run Set file to simplify initiating Plexor® HY runs. Runs can
be initiated by selecting the appropriate Run Set file, editing the Plate file,
if necessary (defining occupied sample wells), and then initiating the run.
See Note at the end of Section 6.B.

Figure 9. The iQ™5 Protocol Editor, displaying the correct Plexor® HY protocol.
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6.B. Plate Setup

1. In the Workshop module Setup tab, select “Plate”, and then select “Create
New” in the selected Plate Setup window (Figure 8, lower right panel).
The Plate Setup Editor will launch (Figure 10).

Figure 10. The iQ™5 Plate Setup Editor.

2. In the Plate Setup Editor, select “Select/Add Fluorophores” to launch the
Fluor Selector. Select “FAM”, “CO560”, “CR610”, and “IC5”, and select
“OK”.

3. Fill in the plate map:
a. In the Plate Setup Editor, select a button in the Fluorophore list to

select the first fluorophore (e.g., FAM).
b. Select the Unknown sample type button above the plate map. Select

the replicate loading type desired from the options on the left of the
plate map (e.g., “By Row and Column”). Use the cursor to define
sample wells with the selected fluorophore (click and drag across the
plate).
Do not highlight wells that are not being used (i.e., wells that do not
contain reaction mix). Including unused wells will significantly affect
the scale of the Y axis when viewing the data.

c. Select the next fluorophore (e.g., CO560) from the Fluorophore list.
Select “Fluorophore loading in whole plate mode” at the top (Paint
Bucket icon). Click on the colored cell in the upper left corner of the
plate map to designate that fluor in all mapped sample wells.

d. Repeat previous step with the remaining two fluorophores (i.e.,
CR610 and IC5).
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6.B. Plate Setup (continued)

4. Specify “Sample Volume” (20µl), “Seal Type” and “Vessel Type”.

5. Enter any notes about the plate setup in the Notes box. Specify a name for
the plate setup file, then select “Save & Exit Plate Editing”.

6. The “Plate Editor” will close, and the display will return to the Setup view
in the Workshop module.
Note: We advise against designating sample types (e.g., standard, NTC,
positive control) or naming samples during setup in the iQ™5 optical
system software, as this information will not be imported into the Plexor®

Analysis Software with the data. Sample names can be entered in the
Plexor® Analysis Software or copied and pasted into the Plexor® Analysis
Software from a Microsoft® Excel spreadsheet. If the user wishes to record
sample names in the iQ™5 plate file, we suggest names be entered into a
Microsoft® Excel spreadsheet and imported into the iQ™5 optical system
software during setup. To perform this function, refer to the guidelines in
the iQ™5 optical system software help file or instrument manual. The
same Excel file can then be used to import sample information into the
Plexor® Analysis Software.
Note: After programming the Protocol and Plate setup files, the user can
link them in a Run Set file to simplify initiating Plexor® HY runs. Runs can
be initiated by selecting the appropriate Run Set file, editing the Plate file,
if necessary (defining occupied sample wells), and then initiating the run.
a. Ensure that the appropriate Protocol and Plate setup files are selected

in the Setup tab in the Workshop module.
b. From the “File” pulldown menu, select “New”, then “Run Set”.
c. When prompted, give the Run Set file an appropriate name and

specify the desired file directory.
d. Select “Save”.

6.C. Initiating a Run

1. Ensure that the appropriate Protocol and Plate Setup files are selected in
the Setup tab in the Workshop module. This can be most easily done by
selecting the Run Set tab and using the browser to select the appropriate
Run Set file.
Note: Make sure that the appropriate sample wells have been mapped in
the active Plate Setup file. Including empty wells will significantly affect
data presentation in Plexor® Analysis Software. Use the Edit button in the
Plate window to launch the Plate Setup Editor, and change the mapped
wells if necessary.

2. Select “Run” in the Run Set window in the Setup tab of the Workshop
module (Figure 8).
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3. The Initiate Run window from the Run-Time Central module will open
(Figure 11). Select the “Collect Well Factor from Experimental Plate” radio
button (see Note at the end of this section).

Figure 11. The iQ™5 Initiate Run window in Run-Time Central module.

4. Select “Begin Run”.

5. A “Save” dialog box will open; specify a name and directory to save the
optical data (.opd) file. Select “Save”.

6. Upon initiating the run, the iQ™5 optical system software will open the
Monitor Run window.
Note: The iQ™5 system uses a “well factor” collection process to
normalize signal intensity across a plate. Before starting a run, the iQ™5
system software will require the user to designate the source of this data,
either the experimental plate or an external well factor plate (a plate
analyzed separately, during an optional calibration step). The
experimental plate method is the simplest and is recommended for
Plexor® HY. When this method is specified, the internal well factor 
data are collected during an initial 90-second process (at denaturing
temperatures), after which the programmed thermal profile is initiated.

7. Data Export from the iQ™5 Optical System Software and Import into the 
Plexor® Analysis Software

After initial processing in the iQ™5 optical system software (Section 7.A), data may be
transferred from the iQ™5 optical system software to the Plexor® Analysis Software in two
ways. The recommended method is to copy and paste data from the iQ™5 optical system
software into the Plexor® Analysis Software (Section 7.B). Alternatively, data may be exported
from the iQ™5 optical system software into Microsoft® Excel. The Excel files are saved, then
imported into the Plexor® Analysis Software (Section 7.C).
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7.A. Initial Data Processing in the iQ™5 Optical System Software

1. Upon completing the run, the iQ™5 optical system software will open a
Run Status window (Figure 12). Choose “Yes” to display the completed
run in the Data Analysis module. An automated analysis will be
conducted, and the data will be presented in the PCR Quant tab of the
Data Analysis module (Figure 13).

2. The default analysis presents data as “PCR Base Line Subtracted Curve
Fit”. Select “Background Subtracted” from the Analysis Mode pulldown
menu.

3. Select “Results”. Data for the first target dye (FAM™) will be presented in
the spreadsheet in the lower window.

4. Select the Amplification Data/RFU tab.

5. Amplification data from these spreadsheets will be copied or exported for
Plexor® analysis.

6. Data for other dyes in the assay can be viewed by selecting the
corresponding button at the bottom of the screen, then selecting the
Amplification Data/RFU tab.

Figure 12. The iQ™5 Run Status window.

Figure 13. The PCR Quant tab of the iQ™5 Data Analysis module. Results view is selected; the
Amplification Data (RFU) spreadsheet is displayed.
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7. To view melt data, select “Melt Curve/Peak” in the Data Analysis module
(Figure 14). Melt data for the first target dye (FAM™) will be presented in
the spreadsheet in the lower window.

8. Select the –d(RFU)/dT tab.
9. Melt data from these spreadsheets will be copied or exported for Plexor®

analysis.
10. Data for other dyes in the assay can be viewed by selecting the

corresponding button at the bottom of the screen, then selecting the
–d(RFU)/dT tab.

Figure 14. The Melt Curve/Peak tab of the iQ™5 Data Analysis module.

7.B. Pasting Data Directly into the Plexor® Analysis Software

This method requires that the iQ™5 optical system software and Plexor® Analysis
Software both be open on the instrument workstation.
Note: Two sets of data (one for the amplification data and one for the melt data)
must be copied from the iQ™5 optical system software and pasted into the Plexor®

Analysis Software for each of the four dyes in the assay.

1. Launch the Plexor® Analysis Software; go to the Start menu and select
“Programs”, then “Plexor”, then select “Analysis Desktop”.
Note: A shortcut can be placed on the desktop by right-clicking on
“Analysis Desktop”, selecting “Copy”, then right-clicking on the 
Windows® desktop and selecting “Paste Shortcut”.

2. In the File menu, select “Import New Run” or select the icon:

Note: Make sure “Set Passive Reference on Import” in the
“File” pulldown menu is selected.

3. Optional: Enter an assay name in the Assay Setup screen, Step 1 
(Figure 15). This screen is used to enter general information about the 
type and format of the data that will be used for each assay.
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7.B. Pasting Data Directly into the Plexor® Analysis Software (continued)

Figure 15. The Assay Setup screen when pasting data directly into the Plexor® Analysis Software.

4. Select “BioRad iQ™5 (via paste)” as the instrument type.
5. Select “Add Target” four times.
6. For each dye, enter a target name and select the dye name from the

pulldown menu (e.g., “Auto” and FAM, “Y” and CO560, “IPC” and
CR610, and “passive reference” and IC5). Indicate there is amplification
data and dissociation (melt) data to be analyzed for the FAM™, CO560
and CR610 dyes.

7. Indicate that the IC5 data are reference data by checking “Pass. Ref.”. 
(The Amplification and Melt boxes for this target will automatically
become deselected.)

8. Select “Next”.
9. Optional: Enter information specific to your run in the Run Info screen,

Step 2 (Figure 16). Details such as the date, notes, title, name of the
researcher, etc., can also be entered in the provided windows.

Figure 16. The Run Info screen when pasting data directly into the Plexor® Analysis Software.
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10. Select “Next”. Use the File Import screen, Step 3 (Figure 17), to paste data
copied from the iQ™5 as described in Steps, 11–18, below.
Note: “Advanced Options” can be used to create templates for routine
plate setups and analysis conditions. See Section 10.G for details
concerning these advanced options and an explanation of the default
analysis settings.

Figure 17. The File Import screen when pasting data directly into the Plexor® Analysis Software.

11. Return to the PCR Quant tab of the Data Analysis module in the iQ™5
optical system software (Figure 13). Select the Amplification Data/RFU
tab in the results spreadsheet for the first dye.

12. Select all data by clicking in the upper left corner of the spreadsheet. 
Use the “Control C” shortcut to copy the data to the computer clipboard.

13. In the Plexor® Analysis Software File Import screen, select “Paste From
Clipboard” for the appropriate dye in the Amplification section to transfer
the data.

14. Repeat Steps 11–13 to copy amplification data for each dye.

15. Return to the Data Analysis module in the iQ™5 optical system software,
and select the Melt Data/Curve tab (Figure 14). Select the –d(RFU)/dT tab
in the results spreadsheet for the first dye.

16. Select all data by clicking in the upper left corner of the spreadsheet. 
Use the “Control C” shortcut to copy the data to the computer clipboard.

17. In the Plexor® Analysis Software File Import screen, select “Paste From
Clipboard” for the appropriate dye in the Melt section to transfer the data.

18. Repeat Steps 15–17 to copy melt data for each dye.

19. When all data have been transferred, select “Finish” in the Plexor®

Analysis Software File Import Screen to complete import and open the
Analysis Desktop.
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7.C. Data Export and Import via Microsoft® Excel

Note: Two files (one for amplification data and one for melt data) must be exported
for each dye used in the run.

1. Navigate to the PCR Quant tab of the Data Analysis module in the iQ™5
optical system software. Select the Amplification Data/RFU tab in the
results spreadsheet for the first dye (Figure 18).

Figure 18. The PCR Quant tab of the iQ™5 Data Analysis module. Results view is selected; the
Amplification Data (RFU) spreadsheet is displayed.

2. Right click in the data spreadsheet, and select “Export to Excel”. Specify a
name for the file, and select “Save”. An Excel workbook will be produced
automatically with the Amplification Data/RFU spreadsheet active.
Note: The saved *.xls file will not be used—data in the open Excel
spreadsheet will resaved in a different format.

3. Save the Amplification Data/RFU spreadsheet as a tab-delimited text file
(*.txt) by using the Save As function from the Excel File pulldown menu.
Specify a file name that describes the dye and indicates that it is an
amplification data set (e.g., ”PlexorHY FAM amp.txt”).

4. Return to the PCR Quant tab of the Data Analysis module in the iQ™5
software. Select the next fluorophore, select the Amplification Data/RFU
tab in the results spreadsheet section, and repeat Steps 2 and 3 for each
dye in the experiment.

5. Return to the Data Analysis module in the iQ™5 software, and select the
Melt Data/Curve tab. Select the –d(RFU)/dT tab in the results spreadsheet
section for the first dye (Figure 19).
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Figure 19. The Melt Curve/Peak tab of the iQ™5 Data Analysis module.

6. Right click in the data spreadsheet, and select “Export to Excel”. Specify a
name for the file, and select “Save”. An Excel workbook will be produced
automatically with the –d(RFU)/dT spreadsheet active.
Note: The saved *.xls file will not be used—data in the open Excel
spreadsheet will be resaved in a different format.

7. Save the –d(RFU)/dT spreadsheet as a tab-delimited text file (*.txt) by
using the Save As function from the Excel File pulldown menu. Specify a
file name that describes the dye and indicates that it is an amplification
data set (e.g., ”PlexorHY FAM melt.txt”).

8. Return to the Melt Data/Curve tab of the Data Analysis module in the
iQ™5 software. Select the next fluorophore, select the –d(RFU)/dT tab in
the results spreadsheet section, and repeat Steps 6 and 7 for each dye in
the experiment.

9. Launch the Plexor® Analysis Software; go to the Start menu and select
“Programs”, then “Plexor”, then select “Analysis Desktop”.
Note: A shortcut can be placed on the desktop by right-clicking on
“Analysis Desktop”, selecting “Copy”, then right-clicking on the
Windows® desktop and selecting “Paste Shortcut”.
Note: Make sure the Set Passive Reference on Import option in the File
pulldown menu is selected.

10. In the File menu, select “Import New Run” or select the icon: 

11. Optional: Enter an assay name in the Assay Setup screen, Step 1 
(Figure 20). This screen is used to enter general information about the 
type and format of the data that will be used for each assay.

12. Select “BioRad iQ™5” as the instrument type.

13. Select “Add Target” four times.
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7.C. Data Export and Import via Microsoft® Excel (continued)

Figure 20. The Assay Setup screen when exporting and importing via Microsoft® Excel.

14. For each dye, enter a target name and select the dye name from the
pulldown menu (e.g., “Auto” and FAM, “Y” and CO560, “IPC” and
CR610, and “passive reference” and IC5). Indicate there is amplification
data and dissociation (melt) data to be analyzed for the FAM™, CO560
and CR610 dyes.
Note: The dye names specified in import must match those in the data
files generated in Section 4.

15. Indicate that the IC5 data are reference data by checking the Pass. Ref.
box. (The Amplification and Melt boxes for this target will automatically
become deselected.)

16. Select “Next”.
17. Optional: Enter information specific to your run in the Run Info screen,

Step 2 (Figure 21). Details such as the date, notes, title, name of the
researcher, etc., can also be entered in the provided windows.

Figure 21. The Run Info screen when exporting and importing via Microsoft® Excel.
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18. Use Step 3 of the File Import screen (Figure 22) to specify the data files
exported from the instrument (Steps 1–10). Use “Browse” to locate the
appropriate exported amplification and melt (dissociation) data files.
When analyzing data with the Plexor® Analysis Software, be sure to
choose the amplification and melt curve files generated using the same
data. The file names assigned when exporting data must be descriptive 
so that the appropriate files can be easily identified and imported into the
Plexor® Analysis Software.
Note: “Advanced Options” can be used to create templates for routine
plate setups and analysis conditions. See Section 10.G for details
concerning these advanced options and an explanation of the default
analysis settings.

19. Select “Finish” to complete the data import and open the Analysis
Desktop.

Figure 22. The File Import Screen when exporting and importing via Microsoft® Excel.
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8. Data Analysis with the Plexor® Analysis Software

After data import is complete (Section 7), the PCR Curves tab of the Analysis Desktop is
displayed (Figure 23).
Note: The columns within any report or table, such as the graph legends shown in Figures 23
and 27, can be reordered by placing the cursor over the column header, then clicking on that
column and dragging it to the desired location. To add or delete columns from a table or
report, right-click on a column, select “Change Columns Shown” and a list of all possible
columns for display will appear. Check or uncheck the appropriates boxes to add or delete
columns, respectively, from the display.
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Figure 23. The PCR Curves tab of the Analysis Desktop. The amplification curves window, melt
curves window and well selector are indicated.

Unknown

No-template control

Standard sample. The concentration is entered in a pop-up window
following designation of a well as a standard.
Create Dilution Series. Selecting the wells and choosing this icon can
automatically create a titration curve across several wells.

Positive control

Color assignment

Figure 24. The icons used to define samples in the Plexor® Analysis Software.
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8.A. Sample Definition

Sample definition, color selection and DNA concentration of standards will be
entered for all dyes.

Use the well selector, which is shown in Figure 23, to select and define each well or
group of wells. Choose one of the icons shown in Figure 24 to define the samples.

Colors can be assigned to samples to provide distinction to the displayed data.
Select the samples, then select “Color Assignment” to apply a color to the selected
sample(s). Assigning or changing a color does not alter the information associated
with a sample. For example, the DNA concentrations of standards will be retained if
the display color associated with those samples is changed.

A sample or set of samples can be permanently deleted from a Plexor® analysis. Go
to the PCR Curves tab, and select the samples. Use the delete key, or select “Remove
Selected Wells” in the Edit menu.

These instructions are for DNA standard setup as described in Section 5.A, using
concentrations in ng/µl. The volume of template used for the DNA standard
reactions must be the same as that for unknowns.

1. Define the DNA standards.
a. Use the well selector to highlight wells that contain DNA standards.
b. Select the Create Dilution Series icon:

c. Confirm that the series selected is “Vertical Series” and the series is
“Decreasing”. Enter 50 for the starting concentration and 5 for the
dilution factor. See Figure 25.

Notes:
1. Results with the 0.0032ng/µl dilution of the DNA standard may

exhibit increased variability compared to those of other standard
dilutions. Definition of the 0.0032ng/µl dilution as a standard is
optional. See Section 8.C. The 0.0032ng/µl dilution should be
included on each plate. Amplification of the 0.0032ng/µl samples
will confirm the sensitivity of the assay in each run.

2. The software does not accept commas or unit definitions in the
concentration assignments.

3. The unit definition for DNA quantity can be changed throughout the
data analysis to describe concentrations in pg/µl rather than ng/µl.
To report concentrations in pg/µl, change the input values as follows:
a. In Step 1.c above, confirm that the series selected is “Vertical

Series” and the series is “Decreasing”. Enter 50000 for the
starting concentration and 5 for the dilution factor.

b. In Section 8.D, Steps 6–8, select the check boxes for picograms
and enter values as pg/rxn and pg/µl.

c. Results in the report sections will now be in pg/µl.

tm296.0212:tm293.0707 2/16/2012 4:01 PM Page 25



8.A. Sample Definition (continued)

2. Define the no-template control reactions.
a. Use the well selector to highlight the wells that contain NTC reactions.
b. Select the NTC icon:

3. Assign sample names to the unknowns.
a. Select the Sample IDs tab (Figure 26). Select the well, and enter the

desired sample name. Repeat to enter sample names for other wells.
b. Enter the same sample name for duplicate samples. The calculated

DNA quantities for samples with the same sample name will be
averaged in the Forensics report (Section 8.D).

c. Names can be copied from a Microsoft® Excel spreadsheet, provided
that the cells are arranged in the same array as your samples 
(e.g., 8 × 12). Highlight the sample names in the spreadsheet, and
select “Copy”. In the Edit menu of the Plexor® Analysis Software,
select “Paste Sample IDs from Template” or use the control T
shortcut. The layout of the sample names in the spreadsheet must be
the same as the layout of the samples within the PCR plate.
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8.B. Adjusting the Expected Target Melt Temperature

Set the expected target melt temperature and expected target melt temperature
range. Failure to set the range for the expected target melt temperature correctly
will cause the results to be incorrectly reported in the graph legend and reports
(Sections 8.D and 8.H). The expected melt temperature range must be adjusted for
all three dye channels (FAM, CO560 and CR610).

The average expected target melt temperature values are instrument-dependent.
However, the average expected target melt temperature for the autosomal target
(FAM) is generally in the range of 79–81°C, and the average expected target melt
temperature for the Y-chromosomal target (CO560) is generally in the range of
81–83°C. The average expected target melt temperature for the IPC (CR610) is
generally in the range of 79–81°C, but for some samples, the IPC Tm value can fall
outside this range by as much as 2°C. Adjust the lower bounds of the expected melt
range to encompass these samples, if desired. Amplification data, in particular the
Ct value, are the primary means of analyzing IPC data.

1. Select the PCR Curves tab. The default setting for the expected target melt
temperature is 90.0, and the default target Tm range is +/–1.5°C.

2. Select wells containing the DNA standards. The Tm for each selected
sample will be displayed in a table to the right of the graph (Figure 27).
The expected target melt temperature and associated target melt
temperature range for all samples in this dye channel should be set based
on the Tm of these standards.

3. In the melt curves window, move the mouse so that the arrow is over the
expected target melt temperature line, and drag it to the midpoint of the
melt curves. Alternatively, double-click on the line, and enter the desired
temperature. See Notes 1–6.
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Figure 27. The target melt temperature is displayed in a table to the right of the graph.
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8.B. Adjusting the Expected Target Melt Temperature (continued)

Notes:
1. The target melt temperature range can be adjusted manually. Move the

mouse so that the arrow is over the upper or lower limit, and drag the
limit to the desired temperature. Alternatively, upper and lower limits can
be adjusted by double-clicking on the appropriate lines and entering an
exact value in the pop-up window that appears.

2. The melt threshold is the level of signal that must be reached for the
Plexor® Analysis Software to “call” the melt results. Target Tm indicators
are included in the table to the right of the amplification and melt curve
windows. See Section 10.E for advanced options to set the melt threshold.

3. A “Yes” or “No” in the Tm? column indicates whether a sample Tm is
within the expected target melt temperature range. A “No Call” in this
column indicates that the melt curve displays the expected target melt
temperature, but there is insufficient amplification product to cause the
melt curve to cross the melt threshold.

4. The “Tm#” is the number of peaks that cross the melt threshold line. More
than one peak indicates heterogeneous amplification products. This may
be due to nonspecific amplification.

5. An increase in Tm for the unknowns relative to that of the DNA standards
may be the result of impurities remaining after DNA extraction. To remove
these impurities, increase the number of wash steps or comparable steps.

6. The default display of the melt curve has not been processed beyond the
melt curve derivation. In some cases it may be helpful to view a smoothed
melt curve using a Gaussian fit of the raw melt curve data to deemphasize
minor variability in the melt data. To change the display, right-click on the
Melt Curves window, choose “Select Melt Data”, then select “Gaussian
Fit”. Note that any melt curve that does not meet the melt threshold will
be rendered as a straight line (y intercept = 0) in this view.

8.C. Generating a Standard Curve and Determining Concentrations of Unknowns

Amplification results from the dilution series of the DNA standard are used to
generate a standard curve. This standard curve is used to determine the DNA
concentration of unknown samples. Samples for generating the standard curve must
be designated as standards (Section 8.A). Standard curves must be generated for the
autosomal (FAM) and Y (CO560) channels.

The Plexor® Analysis Software performs a linear regression to the standard dilution
series data and calculates the equation for the best-fit line (the standard curve). The
equation is in the form of y = mx + b, where x = log concentration and y = Ct (if
using the software default settings). The R2 value is a measure of the fit of the data
points to the regressed line. The slope (m in the equation) is an indication of the
PCR efficiency. A slope of –3.3 indicates 100% PCR efficiency (i.e., the number of
copies of amplification product is doubled at each cycle). The y intercept (b in the
equation) is defined as the y value (Ct) when x (log concentration) equals 0.
Therefore, b gives the Ct for the 1ng/µl standard if concentrations are defined as
described in Figure 25 (log10(1) = 0). If the value for b changes significantly from 
run to run without a change in the slope or R2 value of the standard curve, then this
suggests the DNA standard was not sufficiently mixed before use or has degraded.
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In general, the standard curve for the autosomal target (FAM) has an average slope
(m) in the range of –3.1 to –3.7 and an R2 value ≥0.990. The standard curve for the 
Y-chromosomal target (CO560) generally has an average slope (m) in the range of
–3.0 to –3.6 and an R2 value ≥0.990.

Low R2 values (R2 ≤0.98) may be due to variability in the amplification results for
the replicate samples of the 0.0032ng/µl dilution. The 0.0032ng/µl dilution may
exhibit increased variability compared to the other dilutions of the DNA standard,
most notably in the autosomal reactions. If a low R2 value is observed, change the
sample type for the 0.0032ng/µl standards to “unknown”. The software will
automatically incorporate this change into the standard curves. If this does not
improve the R2 value, proceed to Section 9 and review the comments for “Variability
in signal among replicate samples”, “Nonlinear standard curve, low 
R2 values ≤0.98” and “Slope is outside of the range specified in Section 8.C”.

1. In the autosomal channel (FAM tab), select all samples and DNA
standards. Select “Add Standard Curve” to generate a standard curve and
determine DNA concentrations of the unknowns based on the standard
curve.

Add Standard Curve

2. Repeat Step 1 for the Y channel (CO560 tab).

3. Select the Standard Curves tab to view the standard curves (Figure 28).
One subtab shows the autosomal (FAM) standard curve, and a second
subtab displays the Y (CO560) standard curve. The default display shows
the log concentration on the X axis and cycle threshold on the Y axis.
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Figure 28. The Standard Curves tab.
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8.C. Generating a Standard Curve and Determining Concentrations of Unknowns 
(continued)

4. View DNA concentrations for all samples, including the unknown
samples, in the table next to the standard curve graph (Figure 28). The
calculated concentrations can also be viewed in the sample details report
(Section 8.H).
Note: Samples that do not cross the amplification threshold, such as the
no-template controls, are listed in the graph as not having a valid Ct value.

8.D. Normalization of DNA Quantitation Results for Input into STR Reactions 
and Setup of IPC Parameters

After generating standard curves and quantitating unknowns for autosomal and 
Y-chromosomal DNA, the quantitation results can be used to prepare short tandem
repeat (STR) amplifications. A normalization tool has been incorporated into the
Plexor® Analysis Software to help determine a) which samples are suitable for
analysis, b) which samples require dilution, c) which samples may need
repurification for accurate quantitation, and d) how much sample should be added
to your autosomal STR amplifications (e.g., PowerPlex® 16 reactions) or 
Y-chromosomal STR amplifications (e.g., PowerPlex® Y reactions).

DNA concentrations determined by autosomal and Y-chromosomal quantitation
may differ. Quantitative PCR results and the copy number of the target sequences
can vary. You may see small differences in the quantitation results for the same
sample. The preferred DNA amount for subsequent STR analysis should be defined
through laboratory validation of the STR assays in conjunction with Plexor® HY
quantitation.
Note: Quantitation results for samples with identical sample ID names will be
averaged by the normalization tool.

Following normalization, a new Forensics subtab will be displayed under “Reports”.

In situations where multiple people use the same computer, the parameters entered
in Steps 2–8 will be retained for each Windows® user account when the Plexor®

Analysis Software is closed and reopened, so there is no need to repeat Steps 2–8 
for subsequent runs unless the parameters change.

1. Select “Set Normalization and IPC Parameters” in the Forensics menu.

2. In the dialog box that appears (Set STR Normalization and IPC Parameters;
Figure 29), be sure that the box next to “disable volume normalization
(show concentrations and Ct only)” is not checked. If this box is checked,
STR normalization data will not be displayed in the subsequent forensic
report. See Section 8.F.

3. Optional: If the DNA standards were defined in pg/µl (Section 8.A, 
Step 1), select the check box to set units as picograms. The default display
is nanograms

4. Select the Autosomal STRs tab.

5. Enter the preferred DNA quantity per STR amplification reaction.
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6. Enter the minimum and maximum input volumes of sample (in µl) for
each STR reaction. The limits for pipetting of sample should be defined in
your laboratory. Minimum volume is generally defined by the limits of
the pipettes being used and laboratory guidelines. Maximum volume will
often be defined by the STR reaction volume or laboratory guidelines.

If a single sample volume for STR amplification setup is desired, narrow
this range by entering the same volume for the minimum and maximum
volumes. A broad range of input target quantities and volumes will limit
the number of samples requiring dilution.

7. Enter the minimum and maximum quantity of sample DNA (in
ng/reaction, or pg/reaction if selected above), indicating the lowest and
highest amount of DNA known to produce acceptable STR profiles, as
demonstrated through laboratory validation of the STR assays in
conjunction with the Plexor® HY System.

8. Enter the preferred concentration (in ng/µl, or pg/µl if selected above) to
which overconcentrated samples will be diluted. The concentration entered
must achieve the preferred DNA quantity per reaction entered in Step 5
within the range of the minimum and maximum input volumes chosen in
Step 6.
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Figure 29. The Set STR Normalization and IPC Parameters window.
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8.D. Normalization of DNA Quantitation Results for Input into STR Reactions 
and Setup of IPC Parameters (continued)

9. Select the Y-STRs tab, and repeat Steps 5–8.

10. Select the Internal PCR Control (IPC) tab (Figure 30). If desired, modify
the IPC Ct threshold, which defines the acceptable difference between the
IPC Ct values in DNA standards and samples. The default value is 2 cycles.
If the IPC Ct value in a sample differs from the IPC Ct value in the DNA
standard by more than 2 cycles, “Check IPC” will be displayed in the
Forensics report for that sample. See Section 8.E for more details about
interpreting IPC results and modifying this value.

11. After values for all three tabs [i.e., Autosomal STRs, Y-STRs and Internal
PCR Control (IPC)] have been entered, select “OK”.

12. The Forensics report will be displayed (Figure 31).
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Figure 31. The Forensics report.
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Figure 30. The Internal PCR Control (IPC) tab.
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Definitions and Forensic Report Interpretation

[Auto]: Concentration of total human autosomal DNA in a sample in ng/µl (or
pg/µl if DNA concentrations were entered as pg/µl).

[Y]: Concentration of human male DNA in a sample in ng/µl (or pg/µl if DNA
concentrations were entered as pg/µl).

[Auto]/[Y]: Ratio of total human autosomal DNA concentration to male (Y) DNA
concentration. A very high ratio is indicative of a “male/female” mixture with
minimal male DNA. If the male contributor is of interest, samples with a very high
ratio may benefit from Y-STR analysis in addition to, or instead of, autosomal STR
analysis. Laboratory validation of the Plexor® HY System in conjunction with the
preferred autosomal and Y-STR systems is required to determine a meaningful
value upon which to base this decision.
Note: Due to some individual-to-individual variation in copy number of the
autosomal target and Y-chromosomal target, a single male DNA may not have an
[Auto]/[Y] value of 1.0. Additionally, quantitative real-time PCR has inherent
variation, especially with samples that have higher Ct values (i.e., samples with
lower DNA concentrations). This variation can be reduced by performing replicate
analysis. [Auto]/[Y] values in the range of 0.4 to 2 are commonly observed in
single-source male samples.

The [Auto]/[Y] ratio is not intended to identify minor female contribution in a male
sample. This ratio should be used to form guidelines to suggest when Y-STR
analysis may be a beneficial supplement to autosomal STR analysis (i.e., [Auto]/[Y]
is between approximately 5 and 20) and when only Y-STR analysis is likely to
produce a meaningful STR profile (i.e., [Auto]/[Y] ≥20). Laboratory validation of the
Plexor® HY System, in conjunction with STR analysis, should be performed to
determine these interpretation guidelines.

STR Dilution Status (Autosomal or Y): An indication of whether a sample contains
DNA of adequate concentration to use directly in STR analysis or whether dilution
is necessary. The status terms listed below are established by the values indicated in
the Set STR Normalization and IPC Parameters window (Figure 29). Auto STR
columns use autosomal quantitation results and are intended to guide setup of
autosomal STR reactions. Y-STR columns use Y-chromosomal quantitation results
and are intended to guide setup of Y-STR reactions.
• “No Target” indicates no DNA was detected.
• “Underconc.” indicates that DNA was detected, but the minimum acceptable

DNA quantity (ng or pg per reaction) cannot be achieved with the maximum
volume that has been defined.

• “Below Target” indicates that the specified maximum volume of sample will
deliver an acceptable quantity of DNA but less input DNA than the indicated
preferred DNA quantity.

• “In Range” indicates that the preferred DNA quantity is achievable within the
acceptable volume range.

• “Above Target” indicates that the specified minimum volume of sample will
deliver an acceptable quantity of DNA but will deliver more input DNA than
the preferred DNA quantity.

• “Overconc.” indicates that the maximum acceptable DNA quantity (ng or pg
per reaction) cannot be achieved with the minimum volume that has been
defined. Samples will need dilution.
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8.D. Normalization of DNA Quantitation Results for Input into STR Reactions 
and Setup of IPC Parameters (continued)

STR Volume (Autosomal or Y): The volume (µl) of sample that should be used in
STR analysis. Auto STR columns use autosomal quantitation results and are intended
to guide setup of autosomal STR reactions.Y-STR columns use Y-chromosomal
quantitation results and are intended to guide setup of Y-STR reactions.

STR Quantity (Autosomal or Y): The quantity (ng, or pg if selected) of sample that
will be input into the STR reaction using the indicated “STR Volume”. Auto STR
columns use autosomal quantitation results and are intended to guide setup of
autosomal STR reactions. Y-STR columns use Y-chromosomal quantitation results
and are intended to guide setup of Y-STR reactions.

STR Dilution Factor (Autosomal or Y): The dilution factor necessary to achieve the
desired concentration indicated in the Set STR Normalization and IPC Parameters
window (Section 8.D, Step 7). Only samples indicated as “Overconc.” will have a
dilution factor listed. Auto STR columns use autosomal quantitation results and are
intended to guide setup of autosomal STR reactions. Y-STR columns use 
Y-chromosomal quantitation results and are intended to guide setup of Y-STR
reactions.

IPC Status: An indication of whether the difference between the sample’s Ct values
for the IPC and DNA standard is greater than the designated threshold in the Set
STR Normalization and IPC Parameters window (Figure 29). A difference of less
than the designated threshold is indicated as “OK”; a difference greater than the
threshold is indicated as “Check IPC”.

Curves Status: “OK” indicates the following:

• The sample, if defined as a standard, shows amplification.

• The sample, if defined as a no-template control, shows no amplification.

• If a melt peak is present, the Tm is within the expected range.

“Check STD”, “Check NTC” or “Check Melts” will be displayed if these criteria are
not met.

Note: It is acceptable for the 0.0032ng/µl DNA standard to display “No” or “No
Call” in the “Tm?” column. Verify that if any subthreshold peak is present in the
melt curve, this peak is within the expected target melt temperature range.
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8.E. Analysis of the Internal PCR Control (IPC)

The Internal PCR Control (IPC) is amplified and detected in the CR610 dye channel
under PCR Curves. These data can provide an indication of potential inhibition that
may have affected the quantitation data (FAM and CO560 data). By comparing IPC
Ct values for unknown samples with IPC Ct values for DNA standards, inferences
regarding the presence of inhibitors can be made. Decreasing the IPC threshold
above which a flag is shown (Figure 30) will increase the sensitivity to differences in
the Ct values, while increasing the threshold will necessitate greater IPC Ct value
differences to present the Check IPC flag.

Note: Data from samples are compared to data from DNA standards of similar
autosomal Ct values. The IPC amplification is designed to be the most inhibition-
sensitive or least robust amplification in the triplex.

• If the IPC Ct value of an unknown is several cycles higher than that of DNA
standards with similar total DNA amounts, inhibition may have occurred and
the quantitation data are in doubt. Consider repurifying and requantitating
the sample DNA.
Note: High levels of total human DNA (≥10ng/µl) can cause a slight delay in
the IPC crossing the cycle threshold (1–2 cycles).

• IPC Ct value differences can be used to automatically flag potential inhibition
in the Forensics report as described in Section 8.D, Step 10.

Laboratory validation with relevant inhibitors should be performed to determine
criteria for detecting inhibition.

8.F. Forensic Report Without Normalization

The quantitation results can be reported without normalization of volumes. This
report shows quantitation results and IPC status and curves status columns.

1. Select “Set Normalization and IPC Parameters” in the Forensic menu.

2. Check the box to disable volume normalization (show concentrations and
Ct values only.

3. Select the Forensic tab in the Reports menu.

8.G. Data Export in a 96-Well Format

The quantitation results can be exported in a 96-well format. The exported file is an
Excel spreadsheet, which can be used for automated PCR setup. This export is only
possible after the instructions in Section 8.D are performed.

1. Select “Export 96-well Concentration” in the Forensics menu.

2. Select “Autosomal Concentrations” for the autosomal results, enter a file
name and select “Save”.

3. Select “Y Concentrations” for the Y results, enter a file name and select
“Save”.
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8.H. Supplemental Reports

In addition to the Forensics report described in Section 8.D, the Plexor® Analysis
Software includes five report options: “Sample Details”, “Thresholds”, “Baseline
Regions”, “Run Info” and “Import Files”, which are included as subtabs in the
Reports tab. To view these report options, select the Reports tab. Information is
presented in a tabular format that can be copied, saved or printed using the
provided icons. The saved data can be opened using Microsoft® Excel.

Sample Details: The sample details report includes well location, sample ID, dye
channel, cycle threshold, thermal melt temperature, concentration (if applicable),
whether the sample has the expected Tm and the number of melt curves that cross
the melt threshold line (Figure 32).

A sample with a Ct value of “N/A” has an amplification curve that did not cross the
amplification threshold.

Thresholds: The thresholds report includes the numerical values for the thresholds in
the current analysis (Figure 33). This information can be used to develop an analysis
template for assays where the same or similar thresholds will be used on a routine
basis. See Section 10.G for more information about creating an analysis template.
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Figure 33. The Thresholds tab.
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Figure 32. The Sample Details tab.
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Baseline Regions: The baseline regions report includes the cycle number values that
define the region used to calculate the baseline value for each sample (Figure 34).

Run Info: The run info report includes information from the data import, such as
instrument and date of run (Figure 35).

Import Files: The import files report includes information on the data import files,
such as dye names and file names (Figure 36).
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Figure 34. The Baseline Regions tab.
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Figure 35. The Run Info tab.
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Figure 36. The Import Files tab.
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8.I. Saving and Printing the Analysis File

1. The Plexor® Analysis Software saves the analysis as an *.aan file. The
current analysis can be saved at any time by selecting “Save Analysis File
(.aan)” in the File menu.

2. Selected wells can be exported into a new analysis file. In the File menu,
select “Export Selected Wells as New Analysis File (*.aan)”.

3. The analysis screen can be printed or saved as a screenshot. In the File
menu, select “Save a Screenshot (.png)” or “Print a Screenshot”.

4. A run template and analysis template from an existing analysis can be
exported and used in future analysis (Section 10.G).

9. Troubleshooting

Symptoms Causes and Comments
Flat amplification curve in the Template was degraded or of insufficient quantity. Verify the 
amplification curves window integrity of the DNA template by electrophoresis.
for autosomal and Y channels but Be sure that the reactions were assembled correctly 
not the IPC. The IPC Ct value of Thermal cycler was programmed incorrectly. Verify cycle 
the sample in question was similar times and temperatures (Section 6.A).
to the Ct value of the DNA standards Data collection settings were incorrect. Data collection must 
(no apparent amplification for the occur during the extension step. The extension time must be 
autosomal and Y targets) sufficient for data collection. Verify the data collection settings.

The wrong dye or detector was selected. Be sure the selected 
detectors are appropriate for the fluorescent dyes used.
The passive reference was set incorrectly. Be sure the passive 
reference is set as “IC5” (Section 7.B, Step 7).
The Plexor® HY 2X Master Mix may have lost activity. Be sure 
to store the Plexor® HY System at –20°C to avoid loss of 
enzyme activity. Confirm instrument settings, and review the 
DNA standard amplification data to determine if there is a 
problem with the Plexor® HY System reagents.
The scale of the Y axis was inappropriate. If the scale of the 
Y axis is too broad, the change in fluorescence may not be 
visible. Adjust the scale of the Y axis.

Flat amplification curve in the Amplification inhibitor is present in the DNA template. 
amplification curves window Reduce the concentration or volume of the template in the 
for all channels (i.e., no Ct values) reaction. Repeat the DNA purification if necessary
or for autosomal and Y DNA Sample well(s) did not receive reaction mix. Examine the 
with higher or no Ct values for plate to identify any empty wells. Return to the Plate Setup 
the IPC Editor (Figure 10), and redefine the samples, taking care not 

to define any empty wells. Reexport and reanalyze the data 
(Section 7).
The scale of the Y axis is inappropriate. If the scale of the 
Y axis is too broad, the change in fluorescence may not be 
visible. Adjust the scale of the Y axis.
The Plexor® HY 2X Master Mix may have lost activity. Be sure 
to store the Plexor® HY System at –20°C to avoid loss of 
enzyme activity.
The Plexor® HY 20X Primer/IPC Mix may have been 
degraded. Minimize the number of freeze-thaw cycles.
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Symptoms Causes and Comments
Increasing fluorescence over time The passive reference was set incorrectly. Be sure the passive 

reference is set as “IC5” (Section 7.B, Step 7)
The baseline region was set in a region with significant 
fluorescence fluctuation. The baseline within the baseline 
region should be flat. Manually adjust the baseline region 
(Section 10.C).
The baseline region was set too close to the signal change. 
Manually adjust the baseline region (Section 10.C).

Two or more distinct melt curves Check for signal bleedthrough. Calibrate the instrument as 
or one broad melt curve in the instructed in Section 4.
melt curves window
No melt curve observed in the Poor amplification. See causes and comments for “Flat 
melt curves window amplification curve in the amplification curves window” 

symptoms above.
Problems with data export or instrument analysis have 
occurred. Review the instructions for data export and 
instrument setup.
Data collection settings were incorrect. Verify that the thermal 
cycling program and data collection settings are correct 
(Section 6.A).
Incorrect files were imported. Be sure to import the proper 
files containing related amplification data and dissociation data.
Instrument was programmed incorrectly. Verify that the 
thermal cycling program is correct (Section 6.A).
Sample well(s) did not receive reaction mix. Examine the 
plate to identify any empty wells. Return to the Plate Setup 
Editor (Figure 10), and redefine the samples, taking care not 
to define any empty wells. Reexport and reanalyze the data 
(Section 7).
Melt Curve display has been changed to “Gaussian Fit” mode,
and selected samples do not meet the melt threshold. If 
“Gaussian Fit” mode is selected, the Plexor® Analysis Software 
draws as straight lines (zero slope, zero y-intercept) those 
curves that did not meet the melt threshold at the time of 
import, at the time of opening the *.aan file, or at the time of 
switching from “Raw Data” view to the “Gaussian Fit”. This 
indicates that these curves were not considered for melt peak 
calling (Exp Tm?). Switch the melt curve view to “Raw Data”.

Variability in signal among Calibrate your pipettes to minimize variability when pipetting.
replicate samples Small volumes are difficult to pipet accurately. Do not pipet 

volumes <1µl; we recommend using a sample volume of 2µl 
or higher. If necessary, dilute the template so that larger 
volumes are pipetted.
Some variation is normal. A difference of 1–2 cycles for the Ct
values of replicates is within the normal variation associated 
with an exponential amplification reaction. Ct variation should
be <2 cycles for replicates.
There will be statistical variation in the amount of template in 
a reaction with targets present at low copy number. Poisson 
distribution predicts difficulty associated with reliable detection
of dilute samples with few target molecules.
Mixing was inadequate. Vortex reagents to mix well prior to 
pipetting.
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9. Troubleshooting (continued)

Symptoms Causes and Comments
Variability in signal among Plate performance can differ from manufacturer to 
replicate samples (continued) manufacturer. Use plasticware recommended by the 

instrument manufacturer.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer. Perform a background 
check as directed by the manufacturer.
Viscous samples (e.g., high-molecular-weight genomic DNA) 
are difficult to pipet accurately. Dilute the DNA template.
Store the DNA at 4°C overnight to improve sampling 
consistency.
The plate was not completely sealed. Carefully seal the plates 
to avoid evaporation.
The baseline region was not set correctly. The baseline should 
be flat. The baseline region can be adjusted manually for each 
well to account for sample-to-sample variation (Section 10.C).

Fluorescence decrease observed Reactions were contaminated with target DNA. Human DNA
in the no-template control reaction contamination will produce a melt product similar to that of 

the DNA standard amplifications. Clean workstations and 
pipettes with a mild bleach solution before and after use. Use 
new reagents and solutions. Take precautions to prevent 
contamination. Use separate bench spaces and pipettes when 
handling DNA.
Decrease the cycle number to reduce accumulation of 
nonspecific amplification products.
An improperly calibrated instrument can lead to erratic 
fluorescence readings. Calibrate the instrument as instructed 
by the manufacturer.

Vertical fluorescence spikes or Consult the instrument manufacturer’s user’s guide for 
significant “noise” in the information about potential instrument problems that can 
amplification curve cause spikes or noise.

No amplification or poor amplification for the entire plate. 
Poor amplification can lead to improper data scaling, making 
fluorescence measurements appear erratic. See possible 
causes and comments for “Flat amplification curve in the 
amplification curves window” symptoms above.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.
The passive reference was set incorrectly. Be sure the passive
reference is set as “IC5” (Section 7.B, Step 7).
Sample well(s) did not receive reaction mix. Examine the 
plate to identify any empty wells. Return to the Plate Setup 
Editor (Figure 10), and redefine the samples, taking care not 
to define any empty wells. Reexport and reanalyze the data 
(Section 7).

Small signal change in No amplification or poor amplification. See causes and 
amplification and melt comments for “Flat amplification curve in the amplification 
curves curves window” symptoms above.

Incorrect dye was selected. Verify the presence of the 
appropriate dye.
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Symptoms Causes and Comments
Small signal change in The scale of the Y axis of the amplification curve was affected 
amplification and melt by other reactions on the plate. A high fluorescent signal for 
curves (continued) one or more reactions can cause the scale of the Y axis of the 

amplification curve to be too high to see changes in some data.
Adjust the scale of the Y axis to accommodate samples with 
smaller changes in fluorescence. See Section 10.F.
The passive reference was set incorrectly. Be sure the passive 
reference is set as “IC5” (Section 7.B, Step 7).
Sample well(s) did not receive reaction mix. Examine the 
plate to identify any empty wells. Return to the Plate Setup 
Editor (Figure 10), and redefine the samples, taking care not 
to define any empty wells. Reexport and reanalyze the data 
(Section 7).

Nonlinear standard curve, Be sure that the DNA standard is completely thawed and 
low R2 values ≤0.98 mixed well before use. Store the DNA standard at 4°C 

overnight to improve sampling consistency.
Be sure dilutions of the DNA standard are well mixed before 
removing each aliquot for the serial dilution. Change pipette 
tips between each dilution step.
Calibrate your pipettes to minimize variability when pipetting.
Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; we recommend using a sample volume of 2µl 
or higher. If necessary, dilute the template so that larger 
volumes are pipetted.
Adjust the baseline region. The baseline region can be 
manually adjusted for each reaction. See Section 10.C.
Some variation is normal. Perform duplicate or triplicate 
reactions for the standard curve to minimize the effect of this 
variation.
There will be statistical variation in the amount of template in 
a reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for the standard 
curve. Remove the 0.0032ng/µl dilution of the DNA standard 
from the standard curve by changing the sample type to 
“unknown”.
An error was made during dilution of the DNA standard. 
Verify all calculations, and repeat dilution of the DNA 
standard. Do not pipet volumes <1µl.
Incorrect concentration values were entered in the Plexor®

Analysis Software. Verify the concentrations for all samples 
used to generate the standard curve.
Reactions were contaminated with target DNA. Clean 
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Take 
precautions to prevent contamination.
The plate was not completely sealed. Carefully seal the plates 
to avoid evaporation.
Aberrant fluorescence can be caused by writing on plates, 
contamination, fingerprints, etc. Do not write on the plate. Use
caution when handling plates. Wear gloves. Do not place plates
on surfaces that might be contaminated with fluorescent 
material. If you suspect contamination of the benchtop, thermal
cycler block or any other area, clean it thoroughly.
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9. Troubleshooting (continued)

Symptoms Causes and Comments
Slope is outside of the range No amplification or poor amplification. See causes and 
specified in Section 8.C comments for “Flat amplification curve in the amplification 

curves window” symptoms above.
Nonspecific amplification can become a problem in later 
amplification cycles for samples containing small amounts of 
target template. Decrease the number of amplification cycles.
An error was made during dilution of the DNA standard. 
Verify all calculations, and repeat dilution of the DNA 
standard. Do not pipet volumes <1µl.
There will be statistical variation in the amount of template in 
a reaction with the DNA target present at low copy number. 
Perform duplicate or triplicate reactions for the standard curve.
Remove the 0.0032ng/µl dilution of the DNA standard from 
the standard curve by changing the sample type to “unknown”.
Incorrect concentration values were entered in the Plexor®

Analysis Software (Section 8.A). Verify the concentrations 
for all samples used to generate the standard curve.
There was variability or inaccuracy when pipetting reaction 
components. Calibrate pipettes to improve accuracy.

Unable to import saved data files The data have been altered after export from the real-time PCR 
(Section 7.C). Encountered instrument software. Any alteration of this data is likely to 
“Expecting NEWLINE, found” or change the formatting and can cause import errors. Do not 
“Unexpected Token Error” message open the exported files with other software programs.
Data display appears abnormal in Be sure that the display settings for the computer are set to 
the Plexor® Analysis Software 32-bit color, rather than 16-bit color, when using the Plexor®

(the screen appears compressed, Analysis Software.
lines are replaced with dots, etc.)
Standard curve is not linear An incorrect amplification or melt data set was selected 

during import into Plexor® Analysis Software. If data import 
was via tab-delimited text files (Section 7.C), review the 
Import Files Report (Section 8.H). If data were imported 
by pasting directly into the Plexor® Analysis Software 
(Section 7.B), raw data may be re-imported into a new 
Plexor® file to double-check this step.

All samples show an [Auto]/[Y] See causes and comments for “Standard curve is not linear” 
ratio of 1.0 symptoms above.
Melt peaks for all samples within a See causes and comments for “Standard curve is not linear” 
dye channel have the wrong Tm symptoms above.

10. Appendix

10.A. Plexor® Analysis Software Operating System Compatibility

The Plexor® Analysis Software is compatible with the following operating systems:
Windows® 98, Windows NT® 4, Windows® ME, Windows® XP, Windows® 2000 and
Windows Vista®. Other operating systems are not supported. The Plexor® Analysis
Software is not compatible with Macintosh® operating systems.

Be sure that the display settings for the computer are set to 32-bit color, rather than
16-bit color, when using the Plexor® Analysis Software.
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10.B. Quantitation Using Large Sample Volumes

You may wish to increase input volumes to increase sensitivity or match the input
volume of subsequent STR assays. Laboratory validation is required for any
protocol modifications. The Plexor® HY System allows up to 9µl of input material
per reaction. The sample volume can be increased as long as the final reaction
volume remains constant. The reaction volumes must be the same for both the DNA
standards and unknown samples. This allows the DNA standards to be considered
as a concentration (in ng/µl) instead of input amount in ng (ng/µl × volume).

Table 4 shows the necessary serial dilutions to perform an alternative standard 
curve using 5µl input volumes and DNA standard concentrations in the range of 
1.28pg/µl to 20ng/µl.

Reaction Setup

Prepare the reaction mix by combining the Water, Amplification Grade, Plexor® HY
Master Mix and Plexor® HY Primer/IPC Mix as indicated in Table 5.

If the sample volume is increased, decrease the volume of water added to each
reaction so that the final reaction volume is constant.

Proceed with reaction setup as described in Section 5.B, but dispense 15µl of reaction
mix to wells, rather than 18µl. Add 5µl of sample DNA or DNA standard to each
reaction. Add 5µl of TE–4 buffer to the NTC reactions.

Table 4. Serial Dilution of the Plexor® HY Genomic DNA Standard for the
Alternative Standard Curve (assumes 5µl of DNA per reaction).

Concentration Volume of DNA Volume of TE–4 Buffer
20ng/µl Use 10µl of DNA 15µl
4ng/µl 10µl of 20ng/µl dilution 40µl
0.8ng/µl 10µl of 4ng/µl dilution 40µl
0.16ng/µl 10µl of 0.8ng/µl dilution 40µl
0.032ng/µl 10µl of 0.16ng/µl dilution 40µl
0.0064ng/µl 10µl of 0.032ng/µl dilution 40µl
0.00128ng/µl 10µl of 0.0064ng/µl dilution 40µl

Table 5. Preparation of Reaction Mix for Quantitation Assays 
(5µl of template per reaction).

Component Volume (Per Reaction)
Plexor® HY 2X Master Mix 10µl
Water, Amplification Grade 4µl
Plexor® HY 20X Primer/IPC Mix 1µl
Final volume 15µl
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10.B. Quantitation Using Large Sample Volumes (continued)

Data Analysis

During sample definition (Section 8.A), the dilution series must be modified to
reflect the change in concentration of the DNA standards. When using 5µl input
volumes, note that the dilution series is a decreasing, fivefold dilution series with
“20” as a starting concentration or an increasing fivefold dilution series starting with
“0.00128”, as appropriate for the plate layout used.

10.C. Adjusting the Baseline Region (Optional)

The Plexor® Analysis Software automatically sets the baseline region for each
sample during import. The baseline is set in a flat region of the amplification curve
before product accumulation (i.e., the downward inflection). Manual adjustment of
the baseline region is possible for each sample but rarely necessary. Manual
adjustment might be required for runs where the baseline region is set during or
after amplification (i.e., not within the flat part of the amplification curve; Figures 37
and 38).

In some instances, manual adjustment may provide optimal representation of the
data. This may include samples with excessive noise, bleedthrough or early Ct

values or situations where the real-time instrument shows early signal fluctuation.
Figures 37 and 38 show examples of data with improperly set baseline regions that
should be adjusted manually. In Figure 37, the upper limit of the baseline region
(21.1) is within the visible signal change. The Ct value has been erroneously
increased to accommodate this baseline region. In general, the upper bound of the
baseline region is set several cycles before the amplification curve crosses the
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Figure 37. An amplification window showing an improper baseline region with an improper
baseline upper limit.
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Figure 38. An amplification window showing an improper baseline region with improper upper
and lower limits.
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threshold. In this example, the difference between the upper baseline region bound
and Ct value is only 0.7 cycles. In Figure 38 the lower and upper limits of the
baseline region (32.0 and 35.0, respectively) are set after the visible signal change.
The baseline region must precede the visible amplification. A properly set baseline
region with appropriate lower and upper limits is shown in Figure 39.

1. Select the PCR Curves tab.

2. Select the Display and Manually Adjust Baselines icon:

3. Select the samples to be adjusted using the well selector.
Note: The baseline region can be adjusted for individual samples or
groups of samples by selecting or dragging the lower and upper limits.
The shading in the baseline region will be gray if the selected samples do
not share a common baseline region (Figure 39). The baseline is set
independently for each dye.

4. Adjust the upper limit of the baseline region for each sample so that the
upper limit is approximately 5 cycles before the decrease in fluorescence
and in an area where the baseline is flat. The Ct values for selected
samples are displayed in the table to the right of the graph. The Ct value
may change when the limits are changed. See Notes 1 and 2.

5. If necessary, adjust the lower limit to a region that creates the flattest
baseline given the selected upper limit.

6. Optional: The amplification threshold is based on noise within the
baseline region for all samples. When manual baseline adjustments are
complete, consider recalculating the amplification threshold for all
samples. Select all samples, and in the Edit menu, select “Set Amp
Threshold from Selected Samples” (Section 10.D). See Notes 3 and 4.

Notes:
1. A maximum upper limit of 35 cycles can be used for samples without a Ct

value (e.g., no-template control).
2. Samples with similar Ct values can be adjusted simultaneously by

highlighting multiple wells.

55
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Upper limitLower limit

Baseline
region

Figure 39. An amplification window showing the proper baseline region and baseline upper and
lower limits.
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10.C. Adjusting the Baseline Region (Optional) (continued)

3. To reset the baselines for a selected set of samples, select the samples in
the well selector, and in the Edit menu, select “Set Baselines for Selected
Samples”.

4. The baselines for all samples can be reset to the automatic setting by
selecting the Reset Baselines and Amp Thresholds icon:

10.D. Adjusting the Amplification Threshold (Optional)

The amplification threshold is used to determine the Ct value for the samples
(Figure 40). The default amplification threshold is based on the variation (noise) 
in the baseline regions of all samples. It is determined by calculating the mean 
and standard deviation of all RFU values in the baseline regions and setting the
threshold to 10 standard deviations below the mean.

Optional: The amplification threshold may be reset to change the sensitivity in
detecting the amplification product.

1. To adjust the amplification threshold based on a selected set of samples,
highlight the desired samples in the well selector. In the Edit menu, select
“Set Amp Threshold From Selected Samples”. Enter the number of
standard deviations of the background within the baseline region to use.
The default is 10 standard deviations.

2. To manually adjust the threshold, place the cursor over the threshold, and
drag the line to the desired location. Alternatively, double-click on the
threshold, and enter the desired value.

Changes made to the amplification threshold will apply to the entire data
set within the same dye channel, including those samples that were not
selected.

3. Optional: The amplification threshold is based on noise within the
baseline region for all samples. When manual baseline adjustments are
complete, consider recalculating the amplification threshold for all
samples. See Notes 1 and 2.
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Figure 40. The amplification threshold.
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Notes:
1. The amplification threshold can be reset based on all samples. Select all

samples, and in the Edit menu, select “Set Amp Threshold from Selected
Samples”.

2. The amplification threshold and baselines for all samples can be reset to the
automatic setting by selecting the Reset Baselines and Amp Thresholds
icon:

10.E. Adjusting the Melt Threshold (Optional)

Optional: The melt threshold may be reset to change the sensitivity in detecting the
amplification product. See Notes 1–4. The default melt threshold is set at 25% of the
signal change for the sample within the set that has the greatest change in signal. In
some instances, the sample(s) used to set this threshold may not be typical of the
data set.

To adjust the melt threshold line based on a selected set of samples, highlight the
desired samples in the well selector. In the Edit menu, select “Set Melt Threshold
From Selected Samples”. Enter the desired percentage of signal change.

To manually adjust the melt threshold line, place the cursor over the threshold line,
and drag the line to the desired location. Alternatively, double-click on the
threshold line, and enter the desired threshold value.

Notes:

1. The melt threshold is the level of signal that must be reached for the Plexor®

Analysis Software to “call” the melt results. Target Tm indicators are included
in the table to the right of the amplification and melt curve windows.

2. A “Yes” or “No” in the Tm? column indicates whether a sample Tm is within
the expected target melt temperature range. A “No Call” in this column
indicates that the melt curve displays the correct expected target melt
temperature, but there is insufficient amplification product to cause the
amplification curve to cross the melt threshold.

3. The “Tm#” is the number of peaks that cross the melt threshold line. More
than one peak indicates heterogeneous amplification products or improper
calibration. This may be due to nonspecific amplification.

4. Changes made to the melt threshold line will apply to the entire data set
within the same dye channel, including those samples that were not selected.
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10.F. Adjusting the Y Axes of the Amplification and Thermal Melt Curves 
(Optional)

The scales of the Y axes for the amplification curve and melt curve in an experiment
are determined by the sample that yields the most amplification product (i.e., the
sample with the greatest decrease in signal). These scales are set for the entire data set.

The scale of the Y axis can be set manually by double-clicking on the Y axis of the
graph and entering the new value in the pop-up window. This change will alter the
scale for the entire data set.

10.G. Templates for Routine Setups (Optional)

At the File Import screen, Section 7.B (Figure 17) or Section 7.C (Figure 22), 
there are two Advanced Options buttons: “Run Template” and “Analysis
Template”. These options allow plate configuration and assay parameter
information to be saved for reuse during routine experiments.

Run Template: A run template is used to assign sample types, sample colors and
DNA concentrations of standards (Figure 41). If you routinely use the same setup
for plates of standards and unknowns, a run template can be created, stored and
applied to subsequent runs.

1. Select “Run Template”.

2. Assign colors, sample types and DNA concentrations to the standards in
the Plate Setup tab.
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Figure 41. A Run Template.
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3. Use the Sample IDs tab to label your samples. Simply select the sample
you wish to name and start typing.

4. Select “Export” to save the plate configuration to a *.rtp file for later use.

5. Select “OK”.
Note: To import an existing *.rtp file that contains a saved plate
configuration, select “Import” and browse to that file.

Analysis Template and Definition of Analysis Functions: The analysis template is
used to optimize the analysis settings for the experiment. A template can be set up
to include the expected target melt temperature for each reaction. The expected
target melt temperature should be determined for each real-time instrument. We
recommend the default settings for all other analysis parameters.

1. Select “Analysis Template”.

2. Enter the desired values for the “Expected Target Melt Temperature (Tm)”
for each dye used (Figure 42).
Note: Descriptions of the analysis details are provided below.

3. Select “Export” to save the default settings to a *.ntp file for later use.

4. Select “OK”.

To import an existing *.ntp file that contains the saved default settings, select
“Import” and browse to that file (Section 7.C, Step 18).
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Figure 42. The Analysis Defaults tab.
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10.G. Templates for Routine Setups (Optional) (continued)

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations:
The Plexor® Analysis Software has a user-definable amplification threshold that
determines the RFU value at which sample Ct values are called. This threshold
value is based on the variation (noise) in the baseline regions of all samples and is
determined by calculating the mean and standard deviation of all RFUs in baseline
regions. The threshold is set at a specified number of standard deviations below the
mean. The default threshold is 10 standard deviations but can be changed in the
analysis template or recalculated at any time by using the Set Amp Threshold from
Selected Samples option in the Edit menu (Section 10.D).

Default Melt Threshold –d(RFU)/dT Percentage: The melt curve allows you to
distinguish amplification products with different sequences and lengths. In the
absence of nonspecific amplification products, the melt curve will have one peak.
Each sample has a melt curve, from which a Tm can be determined. A Tm value is
reported for all melt curves that cross the melt threshold and are present within the
expected melt temperature range. The melt threshold represents the –d(RFU)/dT
value that is required before a Tm value is reported for a sample. A sample’s Tm

value is calculated as the temperature at which the melt curve has the lowest (i.e.,
the most negative) –d(RFU)/dT value.

The default melt threshold –d(RFU)/dT percentage is preset at 25.0% and can be set
between 0.0 and 100.0%. This value is used by the software to calculate the melt
threshold value. The Tm threshold value is defined as a percent of the –d(RFU)/dT
value for the sample with the lowest –d(RFU)/dT value in the data set.

See Section 10.E for instructions to adjust the melt threshold.

Expected Target Melt Temperature: The expected target melt temperature is the
melt temperature of the correct PCR product (Section 8.B). The default expected
target melt temperature is 90°C.

Target Tm Upper Bound: The target Tm upper bound is the number of degrees
Celsius above the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm upper bound is +1.5°C.

Target Tm Lower Bound: The target Tm lower bound is the number of degrees
Celsius below the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm lower bound is –1.5°C.
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10.H. Icon Definitions

Assign Color (shortcut = “q”)

The Assign Color function allows you to select a color in which a sample is
displayed. This color selection is associated with those samples in the amplification
and melt curves, well selector and any reports. Select one or more wells using the
well selector, then select this button to choose the desired color for the selected
samples. Sample color does not change the analysis of a sample in any way.

Assign Unknown (shortcut = “w”)

The Assign Unknown function allows you to assign the sample type “Unknown” to
all selected samples. Select one or more wells using the well selector, then select this
button to assign the sample type “Unknown”. Unknown samples are displayed as
open squares in the well selector. They are labeled “Unknown” in reports. When
included in a standard curve, the concentrations of unknown samples will be
calculated and reported if a Ct value is present.

Assign NTC (shortcut = “e”)

The Assign NTC function allows you to assign the sample type “No Template
Control” to all selected samples. Select one or more wells using the well selector,
then select this button to assign the sample type “No Template Control”. No-
template control reactions are displayed as diamonds in the well selector. They are
labeled as “No Template Control” in reports. When included in a standard curve,
the concentration of sample in the no-template control reaction will be calculated
and reported if a Ct value is present.

Assign Positive Control (shortcut = “t”)

The Assign Positive Control function allows you to assign the sample type “Positive
Control” to all selected samples. Select one or more wells using the well selector,
then select this button to assign the sample type “Positive Control”. Positive control
samples are displayed as hexagons in the well selector. They are labeled “Positive
Control” in reports. When included in a standard curve, the concentrations of
positive control samples will be calculated and reported if a Ct value is present.

Assign Standard (shortcut = “r”)

The Assign Standard function allows you to assign the sample type “Standard” to
all selected samples. Select one or more wells using the well selector, then select this
button to assign the sample type “Standard”. Only samples that have been assigned
a type of “Standard” will be used to generate the best-fit line in standard curves. All
DNA standards must be assigned a concentration by the user when they are defined
as a standard. Concentrations may be entered in standard format (0.01, 0.1, 1, 10,
100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). See 
Section 8.A. The software does not accept commas in the concentration assignments.
Standards are displayed as circles in the well selector and standard curve graphs.
They are labeled “Standard” in reports.
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10.H. Icon Definitions (continued)

Create Dilution Series (shortcut = “f”)

The Create Dilution Series function creates a full dilution series within a row or
column of wells. Select the wells that contain a dilution series of the DNA standard,
then select “Create Dilution Series”. You must enter the initial DNA concentration
of the series, the dilution factor and whether the series is increasing or decreasing
(Figure 25). Concentrations may be entered in standard format (0.01, 0.1, 1, 10, 100,
1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). The software does
not accept commas in the concentration assignments.

All selected wells will be assigned the sample type “Standard” with a
corresponding concentration. This function can only be performed with DNA
standards in adjacent rows or columns. Using this function produces the same result
as selecting each well in the series individually and assigning it the sample type
“Standard” with the appropriate concentration. Only samples that have been
assigned the sample type “Standard” will be used to generate the standard curves.

Add Standard Curve (shortcut = “d”)

The Add Standard Curve function fits the experimentally measured Ct values and
user-entered concentration values for DNA standards to a straight line using the
least mean squares method. It will calculate the DNA concentrations of unknown
samples, positive control reactions and no-template control reactions from their
measured Ct values using the equation for the best-fit line. Any sample with a
concentration of “N/A” on the report or elsewhere did not cross the amplification
threshold, so the concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standards, as well as all other samples
for which you wish to calculate concentrations. Choose “Add Standard Curve” from
the Edit menu, and type “d” or select the Add Standard Curve icon on the toolbar.

You may create as many standard curves as you wish for a single set of data, but no
sample can be used to generate more than one standard curve. It is not possible to
add samples to an existing standard curve, but a new curve can easily be
constructed with a new selection. This action will remove the existing standard
curve and generate the new standard curve using the samples you have selected.
You may generate the original standard curve at any time.

Remove Standard Curve (shortcut = “c”)

The Remove Standard Curve function removes the standard curve on the tab that is
currently selected. This function is only available in the Standard Curves tab.

Display and Manually Adjust Baselines

The Display and Manually Adjust Baselines function allows you to set the baseline
range for a sample or set of samples. Select one or more wells using the well
selector, then select this button. See Section 10.C.

Reset Baselines and Amp Thresholds

The Reset Baselines and Amp Thresholds function allows you to reset the baseline
range and amplification threshold for all samples. See Sections 10.C and 10.D.
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10.J. Composition of Buffers and Solutions

10.K. Related Products

Product Size Cat.#
PowerPlex® 16 System 100 reactions DC6531

400 reactions DC6530
PowerPlex® Y System 50 reactions DC6761

200 reactions DC6760
PowerPlex® 16 BIO System 100 reactions DC6541

400 reactions DC6540
PowerPlex® ES System 100 reactions DC6731

400 reactions DC6730
PowerPlex® 1.1 System 100 reactions DC6091

400 reactions DC6090
PowerPlex® 2.1 System 100 reactions DC6471

400 reactions DC6470
Water, Amplification Grade 5 × 1,250µl DW0991

TE–4 buffer (10mM Tris-HCl, 
0.1mM EDTA [pH 8.0])

2.21g Tris base
0.037g EDTA (Na2EDTA • 2H2O)
Dissolve Tris base and EDTA in 900ml
deionized water. Adjust to pH 8.0
with HCl. Bring the volume to 1 liter
with deionized water.
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(a)CAL Fluor® technology is the subject of pending patents and is licensed and sold under agreement
with Biosearch Technologies, Inc., for research and development and forensic and paternity testing.
These products are sold for use by the end-user only and may not be resold, distributed or
repackaged.

(b)This product is sold under licensing arrangements with the USB Corporation. The purchase price
of this product includes limited, nontransferable rights under U.S. Patent Application Serial Number
11/171,008 owned by the USB Corporation to use only this amount of the product to practice the
claims in said patent solely for activities of end users within the fields of life science research and
forensic analysis of genetic material relating to, or obtained as the result of, criminal investigations or
disaster sites conducted either by or for a governmental entity, or for use in or preparation for legal
proceedings, as well as the compilation and indexing of the results of such analysis, and also analysis
for parentage determination (the "Forensic and Genetic Identity Applications Field"). The Forensic
and Genetic Identity Applications Field specifically excludes tissue typing related to transplantation
or other medical procedures. Further licensing information may be obtained by contacting the USB
Corporation, 26111 Miles Road, Cleveland, OH 44128. 

10.K. Related Products (continued)

Sample Preparation Systems

Product Size Cat.#
DNA IQ™ System 100 reactions DC6701

400 reactions DC6700
Maxwell® 16 Instrument 1 each AS2000
Standard Conversion Kit for Maxwell® 16 LEV 1 each AS1200
LEV Conversion Kit for Maxwell® 16 1 each AS1250
DNA IQ™ Reference Sample Kit for Maxwell® 16 48 preps AS1040
DNA IQ™ Casework Sample Kit for Maxwell® 16 48 preps AS1210
Slicprep™ 96 Device 10 pack V1391

ART® Aerosol-Resistant Tips
Size

Product Volume (tips/pack) Cat.#
ART® 10 Ultramicro Pipet Tip 0.5–10µl 960 DY1051
ART® 20E Ultramicro Pipet Tip 0.5–10µl 960 DY1061
ART® 20P Pipet Tip 20µl 960 DY1071
ART® GEL Gel Loading Pipet Tip 100µl 960 DY1081
ART® 100 Pipet Tip 100µl 960 DY1101
ART® 100E Pipet Tip 100µl 960 DY1111
ART® 200 Pipet Tip 200µl 960 DY1121
ART® 1000E Pipet Tip 1,000µl 800 DY1131
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(c)This product is sold under licensing arrangements with Stratagene. The purchase price of this
product includes limited, nontransferable rights under U.S. Pat. Nos. 5,449,603, 5,605,824, 5,646,019
and 5,773,257 owned by Stratagene to use only this amount of the product to practice the claims in
said patent solely for activities of end users within the fields of life science research and forensic
analysis of genetic material relating to, or obtained as the result of, criminal investigations or disaster
sites conducted either by or for a governmental entity, or for use in or preparation for legal
proceedings, as well as the compilation and indexing of the results of such analysis, and also analysis
for parentage determination (the "Forensic and Genetic Identity Applications Field"). The Forensic
and Genetic Identity Applications Field specifically excludes tissue typing related to transplantation
or other medical procedures. Further licensing information may be obtained by contacting the
Business Development Department, Stratagene California, 11011 North Torrey Pines Road, La Jolla,
CA 92037. 

(d)U.S. Pat. No. 6,242,235, Australian Pat. No. 761757, Canadian Pat. No. 2,335,153, Chinese Pat. No.
ZL99808861.7, Hong Kong Pat. No. HK 1040262, Japanese Pat. No. 3673175, European Pat. No.
1088060 and other patents pending. 

(e)The purchase of this product conveys to the buyer the limited, nonexclusive, nontransferable right
(without the right to resell, repackage, or further sublicense) under U.S. Pat. Nos. 5,432,272,
7,422,850, 7,517,651 and 7,541,147 to use the product. No other license is granted to the buyer
whether expressly, by implication, by estoppel or otherwise. In particular, the purchase of this
product does not include or carry any right or license to sell this product. For information on
purchasing a license for other uses, please contact Promega Corporation, Business Development,
2800 Woods Hollow Road, Madison, WI 53711, or EraGen Biosciences, Corporate Licensing, 918
Deming Way, Suite 201, Madison, WI 53717. Phone (608) 662-9000; Fax (608) 662-9003. 

(f)Use of this product for basic PCR is outside of any valid US or European patents assigned to
Hoffman La-Roche or Applera. This product can be used for basic PCR in research, commercial or
diagnostic applications without any license or royalty fees. 

© 2012 Promega Corporation. All Rights Reserved.

Maxwell, Plexor and PowerPlex are registered trademarks of Promega Corporation. DNA IQ and
Slicprep are trademarks of Promega Corporation.

ART is a registered trademark of Molecular Bio-Products, Inc. CAL Fluor is a registered trademark 
of Biosearch Technologies, Inc. FAM is a trademark of Applera Corporation. iQ is a trademark of
Bio-Rad Laboratories, Inc. Macintosh is a registered trademark of Apple Computer, Inc. Microsoft,
Windows, Windows NT and Windows Vista are registered trademarks of Microsoft Corporation.

Products may be covered by pending or issued patents or may have certain limitations. Please visit
our Web site for more information.

All prices and specifications are subject to change without prior notice.

Product claims are subject to change. Please contact Promega Technical Services or access the
Promega online catalog for the most up-to-date information on Promega products.
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